Introduction

This chapter provides instructions on performing advanced data management tasks.

Converting a Character column to a Numeric column

Sometimes numeric data is stored in columns that have character data types. In order to do calculations with this numeric data, you must convert the character columns to numeric. You can use Subset/Copy on the Data Management menu to change a column from a character to a numeric format. In this section, you convert the character column DAY, which is found in the ORANGES table, to a numeric column. The value in the character column DAY is a (character) number from 1 to 6.
Additional Information

For additional information on changing columns from character to numeric and vice versa, refer to the PUT and INPUT functions and formats and informats in SAS Language Reference: Dictionary.

Instructions

1. Follow this selection path:
   - Tasks ➤ Data Management ➤ Subset/Copy
   
The Subset or Copy a Table window appears.

**Display 3.1** Subset or Copy A Table Window

2. Use the **Table** button to select the SASUSER.ORANGES table.

3. Select **Output data**. The Output Table or View window appears.
4 Type **ORANGNUM** in the Table/View field.
   ORANGNUM is a new table that you create to contain the new numeric column DAYNUM. By leaving the defaults of Temporary and Table selected, you create a temporary table in the WORK library, which is deleted when you exit the SAS System. An indicator next to Temporary and Table shows that these items are selected.

5 Select **OK** to return to the Subset or Copy a Table window.

6 Select **Define new columns**. The Define or Modify a column window appears.
You use this window to define the new columns that you are adding to the output table.

7 In the **column** field, type **DAYNUM** as the name of the column.

8 Leave the **Length** as 8.

   Leave the **Type** as **Numeric**.

9 Select **Initialize**. The Enter Numeric Expression window appears.
Display 3.4  Enter Numeric Expression Window

You use this window to build an expression that is used to define the new column.

10 Select **Function**. The Select the Type of Function window appears.
Select Character functions. The Select Data window for character functions appears.

Display 3.6  Select Character Function Window
12 Select `INPUT(c,ifmt)`. The Specify Arguments to a Function window appears.

**Display 3.7  Specify Arguments to a Function Window**

You select `INPUT(c,ifmt)` because the source column DAY is character.

13 In the `Value for parameter` field next to `CHAR`, type `DAY`.

In the `Value for parameter` field next to `INFORM`, type `2.1`.

You type `DAY` in the `CHAR` parameter field because you want to use the values of the DAY column in the ORANGES table as the source for the DAYNUM column that you are creating.

The informat 2.1 is used in this example so you can check to see that this task completed correctly. However, you can use any valid informat. In this example, if you select a format such as 1., the only indication that the new column is numeric is that it is right justified when displayed in the FSVIEW window. However, if you use 2.1 as an informat, the new column DAYNUM is right justified and converted to display tenths.

14 Select `OK` four times until you return to the Subset or Copy a table window.

Follow this selection path:

```
Run  ➤ Submit
```

When prompted, select `OK`, then `Goback` to view the new table.

The new DAYNUM column is created, and the data is copied to the output table. An FSVIEW window appears with the data in the output table.

15 Scroll to the right or use the RIGHT command or function key to see the new column DAYNUM.
To confirm that the column is numeric, browse the properties of the table. See “Altering the Properties of a SAS Table” on page 30 for more information.

To exit the FSVIEW window, follow this selection path:

File ➤ Close

Converting Character Dates and Times to SAS Date and Time Values

You can use the above procedure to convert character dates and times to SAS date and time values. In the Specify Arguments to a Function window, specify an appropriate date, time, or datetime informat for INFORM. For example, if you have a column of character dates in the form 05MAR1999, use the DATE9. informat. In the Define or Modify a Column window, you might want to specify an appropriate date, time, or datetime format by selecting Format.

Combining Data Using a Cartesian Product Match Merge

You can use Combine on the Data Management menu to combine your data in several ways. You can concatenate, interleave, merge, or match merge your data. The Match Merge item enables you to perform a SAS match merge or Cartesian product match merge.

In this section, you use Combine on the Data Management menu to perform a Cartesian product match merge using the AIRLINE.SCHEDULE and AIRLINE.STAFF...
sample tables. If you have not created the AIRLINE sample tables, see “Creating the AIRLINE Sample Tables” on page 3.

The AIRLINE.STAFF table contains data on each employee, such as first name, last name, and employee number. The AIRLINE.SCHEDULE table includes information about what personnel are assigned to each flight during the first week of March, including flight number, date, and employee number. This Cartesian product matches the first name and last name of each employee to the flights to which they are assigned. The employee and the schedule information are matched using the employee number found in both tables. You create a new table, WORK.STAFSKED, that contains the merged data.

The following displays show listing reports of the AIRLINE.STAFF and AIRLINE.SCHEDULE tables before they are merged.

Display 3.9  AIRLINE.STAFF Table

```
<table>
<thead>
<tr>
<th>ID number</th>
<th>Last name</th>
<th>Firstname</th>
<th>City</th>
<th>State Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>1919</td>
<td>Adams</td>
<td>Gerald</td>
<td>Stanford</td>
<td>CT</td>
</tr>
<tr>
<td>1653</td>
<td>Alexander</td>
<td>Susan</td>
<td>Bridgeton</td>
<td>CT</td>
</tr>
<tr>
<td>1499</td>
<td>Apple</td>
<td>Tony</td>
<td>New York</td>
<td>NY</td>
</tr>
<tr>
<td>1350</td>
<td>Arthur</td>
<td>Barbara</td>
<td>New York</td>
<td>NY</td>
</tr>
<tr>
<td>1461</td>
<td>Avery</td>
<td>Jerry</td>
<td>Paterson</td>
<td>NJ</td>
</tr>
<tr>
<td>1428</td>
<td>Biewfoot</td>
<td>Joseph</td>
<td>Princeton</td>
<td>NJ</td>
</tr>
<tr>
<td>1101</td>
<td>Bailey</td>
<td>Walter</td>
<td>New York</td>
<td>NY</td>
</tr>
<tr>
<td>1333</td>
<td>Blair</td>
<td>Justin</td>
<td>Stanford</td>
<td>CT</td>
</tr>
<tr>
<td>1402</td>
<td>Blalock</td>
<td>Ralph</td>
<td>New York</td>
<td>NY</td>
</tr>
<tr>
<td>1479</td>
<td>Bostic</td>
<td>Marie</td>
<td>New York</td>
<td>NY</td>
</tr>
<tr>
<td>1493</td>
<td>Border</td>
<td>Earl</td>
<td>Bridgeton</td>
<td>CT</td>
</tr>
<tr>
<td>1739</td>
<td>Boyce</td>
<td>Jonathan</td>
<td>New York</td>
<td>NY</td>
</tr>
<tr>
<td>1658</td>
<td>Bradley</td>
<td>Jeremy</td>
<td>New York</td>
<td>NY</td>
</tr>
<tr>
<td>1428</td>
<td>Braley</td>
<td>Christine</td>
<td>Stanford</td>
<td>CT</td>
</tr>
<tr>
<td>1702</td>
<td>Brown</td>
<td>Jason</td>
<td>Stanford</td>
<td>CT</td>
</tr>
<tr>
<td>1244</td>
<td>Bryant</td>
<td>Leonard</td>
<td>New York</td>
<td>NY</td>
</tr>
<tr>
<td>1505</td>
<td>Burdette</td>
<td>Thomas</td>
<td>New York</td>
<td>NY</td>
</tr>
<tr>
<td>1574</td>
<td>Canill</td>
<td>Marshall</td>
<td>New York</td>
<td>NY</td>
</tr>
<tr>
<td>1769</td>
<td>Carnaby</td>
<td>David</td>
<td>New York</td>
<td>NY</td>
</tr>
<tr>
<td>1494</td>
<td>Carter</td>
<td>Donald</td>
<td>New York</td>
<td>NY</td>
</tr>
<tr>
<td>1437</td>
<td>Carter</td>
<td>Dorothy</td>
<td>Bridgeton</td>
<td>CT</td>
</tr>
<tr>
<td>1638</td>
<td>Carter</td>
<td>Karen</td>
<td>Stanford</td>
<td>CT</td>
</tr>
<tr>
<td>1253</td>
<td>Caston</td>
<td>Franklin</td>
<td>Stanford</td>
<td>CT</td>
</tr>
<tr>
<td>1065</td>
<td>chimney</td>
<td>Neil</td>
<td>New York</td>
<td>NY</td>
</tr>
<tr>
<td>1076</td>
<td>Chin</td>
<td>Jack</td>
<td>New York</td>
<td>NY</td>
</tr>
<tr>
<td>1007</td>
<td>Chin</td>
<td>Jane</td>
<td>Stanford</td>
<td>CT</td>
</tr>
<tr>
<td>1129</td>
<td>Cook</td>
<td>Brenda</td>
<td>New York</td>
<td>NY</td>
</tr>
<tr>
<td>1598</td>
<td>Cooper</td>
<td>Anthony</td>
<td>New York</td>
<td>NY</td>
</tr>
</tbody>
</table>
```
For additional information about concatenating, interleaving, merging, or match merging your data, refer to the information on the SET and MERGE statements in SAS Language Reference: Dictionary.

**Instructions**

1. To display the Match Merge SAS Tables window, follow this selection path starting from the WorkPlace menu:

   ![Tasks](Tasks) ➤ ![Data Management](Data Management) ➤ ![Combine](Combine) ➤ ![Match merge](Match merge)

   ➤ ![Second Method](Second Method)

   The Match Merge SAS Tables window appears.
2 Use the First table button to select the AIRLINE.SCHEDULE table.

3 Use the Second table button to select the AIRLINE.STAFF table.

4 Select Output Table. The Output Table or View window appears. The Output Table or View window is identical to that shown in Display 3.2 on page 17.

5 Type STAFSKED in the Table/View field as the name of the output table.

6 Select OK to return to the Match Merge SAS Tables window.

   By leaving the defaults of Temporary and Table, a temporary table is created in the WORK library. The WORK.STAFSKED table is deleted when you exit the SAS System. An indicator next to Temporary shows that this item is selected.

7 Select Type of column used to match merge the tables. The Select a Merge Method window appears.

8 Select Combine by columns common to both tables because the employee number column has the same name in both tables.

   You combine the columns unique to each table when each table has columns with the same values but different names, for example, if the employee number is named EMPNUM in one table and IDNUM in the other. You combine the columns common to both tables when each table has a column with the same name and the same values, for example, if each table has a column called EMPNUM with the same employee number values.

   The Match Merge by Common Columns window appears with a list of columns common to both tables, that is, having the same name and same data type. The only column common to both tables is IDNUM.
9 Select IDNUM, and then select OK to return to the Match Merge SAS Tables window.

10 Choose Select unique existing columns. The Select Existing columns window appears.
11 Select, in this order, **FLIGHT**, **DATE**, **FNAME**, and **LNAME** as the columns to be included in the new table WORK.STAFSKED. The order in which you select these columns determines the order in which they appear in the new table.

12 Select **OK** to return to the Match Merge SAS Tables window.

13 Follow this selection path:

   ![Diagram](image)

   When prompted, select **OK**, and then select **Goback** to view the new table. The new table appears in an FSVIEW window.
Creating a Format

The SAS System uses formats and informats to interpret your data. Formats determine how a column value should be displayed, and informats determine how values entered in column fields should be interpreted. You can design your own formats and informats by using Design Format on the Data Management menu. Once you create the formats and informats, you can use them whenever you are prompted for a format or informat for a column.

In this section, you create a numeric format, COSTRNGE., that determines whether the cost of a house in the HOUSES table is low, medium, or high depending on the range in the format. You use this format in the following section, “Altering the Properties of a SAS Table” on page 30.

Additional Information

For additional information about creating formats and informats, refer to “The FORMAT Procedure” chapter in the SAS Procedures Guide.
Instructions

1. To display the Create Formats window, follow this selection path:
   
   Tasks ▶ Data Management ▶ Design Format ▶ Create formats

   The Create Formats window appears.

   Display 3.15  Create Formats Window

2. In the The format name field, type COSTRNGE as the name of the format.

3. Select Numeric as the type of format.

4. Type 3 in The number of groups required field. The number of groups indicates how many values or ranges you want to use for the format.

5. Select Ranges. The Specify Format Ranges window appears.
Display 3.16 Specify Format Ranges Window

You select **Ranges** because low, medium, and high cover a range of prices, not specific values.

6 For Group 1, type 1 as the **From Value**, 50000 as the **To Value**, and **Low** as the **Formatted Value**.

   For Group 2, type 50001, 100000, and **Medium** for the **From Value**, **To Value**, and **Formatted Value**, respectively.

   For Group 3, type 100001, 999999, and **High** for the **From Value**, **To Value**, and **Formatted Value**, respectively.

7 By leaving the default of **Temporary**, a temporary format is created in the WORK.FORMATS catalog. The WORK.FORMATS catalog is deleted when you exit the SAS System. An indicator next to **Temporary** shows that this item is selected. If you select **Permanent**, the format is permanently stored in the SASUSER.FORMATS catalog.

8 Select **OK** twice to create the format. A message appears, indicating that the format was created. Note that a period was appended to the end of the COSTRNGE. format.

9 To return to the WorkPlace menu from the message window, select **Goback** twice.

You can now use this format in the HOUSES table. In the following section, you use the Properties window to apply the COSTRNGE. format to the HOUSES table.

### Altering the Properties of a SAS Table

The properties of a SAS table describe information about the table. Using **Utilities** on the Data Management menu, you can access the Properties window to browse or
alter a table’s properties. The properties of a table include the table name, engine, date created, date last modified, and number of rows, along with additional information. Of the table attributes, you can edit the table type and label. In addition, the Properties window displays information about each column, including the name, type, length, position, label, format, and informat, and whether or not the column serves as an index for the table. The name, label, format, and informat for each column can be edited.

In this section, you change the format of the PRICE column in the HOUSES table, the label for the BEDROOMS column, and the label of the table. This process uses the COSTRNGE format that you created in the previous section. After you change the table, you run the following listing report to view your changes.

The following listing report shows the unaltered HOUSES table.

Display 3.17  Listing of Unaltered HOUSES Table

<table>
<thead>
<tr>
<th>Style of homes</th>
<th>Square footage</th>
<th>Number of bedrooms</th>
<th>Number of bathrooms</th>
<th>Street address</th>
<th>As</th>
</tr>
</thead>
<tbody>
<tr>
<td>RANCH</td>
<td>1259</td>
<td>2</td>
<td>1.0</td>
<td>Shoppard Avenue</td>
<td></td>
</tr>
<tr>
<td>SPLIT</td>
<td>1159</td>
<td>1</td>
<td>1.0</td>
<td>Rand Street</td>
<td></td>
</tr>
<tr>
<td>CONDO</td>
<td>1400</td>
<td>2</td>
<td>1.5</td>
<td>Market Street</td>
<td></td>
</tr>
<tr>
<td>TOWNSTORY</td>
<td>1810</td>
<td>4</td>
<td>3.0</td>
<td>Gorris Street</td>
<td></td>
</tr>
<tr>
<td>RANCH</td>
<td>1500</td>
<td>1</td>
<td>1.0</td>
<td>Kenble Avenue</td>
<td></td>
</tr>
<tr>
<td>SPLIT</td>
<td>1615</td>
<td>3</td>
<td>3.0</td>
<td>West Drive</td>
<td></td>
</tr>
<tr>
<td>CONDO</td>
<td>1305</td>
<td>4</td>
<td>1.5</td>
<td>Graham Avenue</td>
<td></td>
</tr>
<tr>
<td>TOWNSTORY</td>
<td>1049</td>
<td>3</td>
<td>2.5</td>
<td>Hampshire Avenue</td>
<td></td>
</tr>
<tr>
<td>CONDO</td>
<td>2105</td>
<td>4</td>
<td>2.5</td>
<td>Sanders Road</td>
<td></td>
</tr>
<tr>
<td>RANCH</td>
<td>1505</td>
<td>3</td>
<td>3.0</td>
<td>Joanna Avenue</td>
<td></td>
</tr>
<tr>
<td>TOWNSTORY</td>
<td>1249</td>
<td>2</td>
<td>1.0</td>
<td>Fairbanks Circle</td>
<td></td>
</tr>
<tr>
<td>RANCH</td>
<td>720</td>
<td>1</td>
<td>1.0</td>
<td>Nicholson Drive</td>
<td></td>
</tr>
<tr>
<td>TOWNSTORY</td>
<td>1745</td>
<td>4</td>
<td>2.5</td>
<td>Highland Road</td>
<td></td>
</tr>
<tr>
<td>CONDO</td>
<td>1860</td>
<td>2</td>
<td>2.0</td>
<td>Arlata Avenue</td>
<td></td>
</tr>
</tbody>
</table>

Additional Information

For additional information on altering the properties of a SAS table, see “The DATASETS Procedure” in SAS Procedures Guide.

Instructions

1 To edit the properties of a SAS table, follow this selection path:

   | Tasks ➤ Data Management ➤ Utilities ➤ Contents of a table ➤ Edit SAS table contents |
The Select Table window appears.

2 Select the SASUSER.HOUSES table and select OK.

The Properties window opens with information about the HOUSES table.

Display 3.18  Properties Window for HOUSES table

3 Select the down arrow at the top of the window, and then select columns. A list of columns in the HOUSES table appears.

4 For mainframes: In the command field for the PRICE column, type S (for Select) and press ENTER. Then, type S in the command field for Format and press ENTER. For desktops: Right-click the Price column and select Modify Format.

The Modify window appears for the Format attribute.
5 Type `COSTRNGE .` over `DOLLAR12 .` and select `OK`. The Properties window reappears with the new format.

6 Repeat the previous two steps to change the label of the `BEDROOMS` column to `Bedrooms`. (If necessary, type blanks over any leftover letters from the old label.)

7 Select the down arrow at the top of the window, and then select `General Properties`.

8 For mainframes: Type `M` in the command field for `Label` and press ENTER. For desktops: Double-click the `Label` attribute.

9 Type `Houses for sale` over the existing label. Type blanks over any leftover letters from the old label.

10 Follow this selection path to return to the WorkPlace menu:

```
OK ➤ OK ➤ Goback
```

11 To display a listing report for the modified `HOUSES` table, follow this selection path:

```
Tasks ➤ Report Writing ➤ Listing
```

If `SASUSER.HOUSES` is not the active table, use the `Table` button to select the `SASUSER.HOUSES` table. Follow this selection path to view the table:

```
Run ➤ Submit
```
Notice the changes in the formats and labels.

Follow the directions in “Returning to SAS/ASSIST Windows from the Output Window” on page 9 to return to SAS/ASSIST software.

Transporting SAS Files Across Operating Environments

You can use SAS/ASSIST software to prepare SAS files for transport to another operating environment. Utilities on the Data Management menu enables you to convert a SAS file into transport format, and to convert a transport file to a SAS file. In this section, you convert the SASUSER.VENEER table into transport format. A file that is in transport format can be transported to a different operating environment, for example, across a network using File Transfer Protocol (FTP). In addition to SAS tables, you can also convert SAS libraries and catalogs to transport format.

Additional Information

For additional information about converting SAS files from one format to another, refer to “The CPORT Procedure” and “The CIMPORT Procedure” in the SAS Procedures Guide.

Instructions

Follow this selection path:
2 Use the **Input SAS table name** button to select the SASUSER.VENEER table.

3 If desired, select **Output file name**; the Select External File Name window appears. Alternatively, you can accept the default output file name. See the following table for a list of default file names.
4 In the **External file name** field, type the name of the file as is appropriate for your operating environment to transport the VENEER table. Use the following table as a guide.

<table>
<thead>
<tr>
<th>Operating Environment</th>
<th>What You Type</th>
<th>Example</th>
<th>Transport File</th>
</tr>
</thead>
<tbody>
<tr>
<td>OS/390</td>
<td>an operating system data set name, and if a partitioned data set is used, a member</td>
<td>USERID.DATA. SASDATA VENEER (VENEER)</td>
<td>USERID.SASCAT.DATA</td>
</tr>
<tr>
<td>CMS</td>
<td>the file name, file type, and file mode</td>
<td>VENEER FILE A</td>
<td>SASCAT DATA in the first R/W accessed disk</td>
</tr>
<tr>
<td>OpenVMS</td>
<td>the name of a device, directory, and filename</td>
<td>DEVICE:[SASDATA] VENEER.DAT</td>
<td>SASCAT.DAT in the default directory</td>
</tr>
<tr>
<td>UNIX</td>
<td>the name of a directory or subdirectory and a filename</td>
<td>/u/userid/sasdata/ veneer</td>
<td>sascat.dat in the working directory</td>
</tr>
<tr>
<td>OS/2 or Windows</td>
<td>the name of a drive, directory or subdirectory, and a filename and extension</td>
<td>C:\SASDATA\ VENEER.DAT</td>
<td>SASCAT.DAT in the working directory</td>
</tr>
</tbody>
</table>

5 Select **Filename** because you typed a filename and not a fileref.
6 Select **OK** to return to the Convert a SAS Table window.
7 Follow this selection path to create the transport file:

Run ➤ Submit
The Log window appears, displaying information to indicate that the table was converted successfully.

**Display 3.23  Log Window with Conversion Results**

![Log Window with Conversion Results](image)

Note: Under some operating environments, such as OS/390, if the external file does not exist, a message appears asking if you want to create it. Under other operating environments, you need to create the external file before you can output a transport table to it. See the SAS companion documentation for your operating environment for more information.

To return to SAS/ASSIST software from the Log window, follow this selection path:

**Solutions ▶ ASSIST**

You can now transport your file to another operating environment. To convert the file back to SAS file format on the other operating environment, follow this selection path:

**Tasks ▶ Data Management ▶ Utilities ▶ Convert from CPORT format ▶ Table**

Use the buttons in the Convert a Transport File window to specify the input file name and output table name.

---

**Transposing a Table**

You can use **Transpose table** under **Utilities** on the Data Management menu to invert a table. Transposing a table turns the rows of a table into columns and vice versa.
In this section, you first sort the ORANGES table in order of the store number because you group the transposed rows by store. Then you transpose the sorted table so that the price for the first variety of oranges becomes a row with a separate column for each day’s price.

The following display shows a listing report of the ORANGES table before it is transposed.

**Display 3.24** Listing of ORANGES Table Before Transposing

![Listing of ORANGES Table Before Transposing](image)

---

**Additional Information**

For additional information, refer to “The TRANSPOSE Procedure” in the SAS Procedures Guide.

---

**Instructions**

1. To display the Sort a Table window, follow this selection path:
   
   Tasks ➤ Data Management ➤ Sort
2 Use the **Table** button to select the SASUSER.ORANGES table.

3 Select **Output table**. The Specify Output Table window appears. The Specify Output Table is identical to the window shown in Display 3.2 on page 17.

4 In the **Table** field, type **ORGSORT** as the name of the output table.

   By leaving the default of **Temporary**, a temporary table is created in the WORK library. The WORK.ORGSORT table is deleted when you exit the SAS System. An indicator next to **Temporary** shows that this item is selected.

5 Select **OK** to return to the Sort a Table window.

6 Use the **Sort by columns** button to select the **STORE** column.

7 Select **OK** to return to the Sort a Table window.

8 To sort the table, follow this selection path:

   ![Run Submit](image)

   A message appears to indicate that the table was successfully sorted.

9 Select **Goback**.

10 Follow this selection path to open the Transpose a Table window:

   ![Tasks Data Management Utilities Transpose Table](image)

   The Transpose a table window appears.
11 The WORK.ORGSORT table should already be listed for Table. If not, use the Table button to select the WORK.ORGSORT table.

12 Select Output table. The Specify Output Table window appears.

13 In the Table field, type ORGTRANS as the name of the output table, then select OK to return to the Transpose a Table window.

By leaving the default of Temporary, a temporary table is created in the WORK library. The WORK.ORGTRANS table is deleted when you exit the SAS System. An indicator next to Temporary shows that this item is selected.

14 Use the Columns to be transposed button to select the PRICE1 column as the column to be transposed (that is, changed to a row).

15 Select Additional options. The Additional Transpose Options window appears.
16 Use the Group the transposed rows button to select the STORE column as the column you want to use as a grouping column.

17 Use the column to be used to label transposed columns button to select the DAY column as the label you want to use to label the columns of the transposed data in the ORGTRANS output table.

The SAS System generates a row for each column that is being transposed for each group.

18 In the Additional Transpose Options window, position the cursor in the Prefix field and type Day as the prefix to each number that represents a day of the week.

Make sure each formatted value of the DAY column occurs only once in each group of the active table. Duplicate values produce a warning message in the LOG window and stop the procedure.

19 Select OK to return to the Transpose a Table window.

20 To transpose the table, follow this selection path:

Run ➤ Submit

A message appears asking if you want to view the transposed table. Select OK, then Goback. The transposed table appears in an FSVIEW window.
Display 3.28  Transposed Table

Use the scroll bars or the RIGHT command or function key to display the rest of the transposed data.

21 To exit the FSVIEW window, follow this selection path:

File ➤ Close